
 

 

Class: 12th 

Subject: Computer  

Chapter 7: MICROSOFT ACCESS-FORMS AND 
REPORTS 

 

‎📍Important MCQs: 

1. MS Access Form is mainly used to: 

(a) Store data permanently 

(b) Create queries 
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(c) Enter, view, and edit data ✅ 

(d) Delete tables 

2. Forms in MS Access provide an alternative way to: 

(a) Design databases 

(b) Enter data into tables ✅ 

(c) Create reports 

(d) Store queries 

3. The individual design elements used to construct a form 

are called: 

(a) Fields 

(b) Records 

(c) Controls ✅ 

(d) Tables 

4. Which control is used to enter and edit data in a form? 

(a) Label 

(b) Button 
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(c) Text box ✅ 

(d) Object frame 

5. Labels in a form are mainly used to: 

(a) Store values 

(b) Display field names ✅ 

(c) Run queries 

(d) Sort data 

6. Which tool assists users in creating forms easily in MS 

Access? 

(a) Query Wizard 

(b) Report Wizard 

(c) Form Wizard ✅ 

(d) Table Wizard 

7. Which type of form displays only one record at a time in 

a vertical format? 

(a) Tabular Form 

(b) Datasheet Form 
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(c) Columnar Form ✅ 

(d) Graph Form 

8. Tabular Form is best used when: 

(a) Displaying one record only 

(b) Displaying graphics 

(c) Displaying multiple records at once ✅ 

(d) Designing reports 

9. Datasheet Form initially displays data similar to: 

(a) Report view 

(b) Form view 

(c) Table datasheet view ✅ 

(d) Design view 

10. To create a form without using the wizard, which view 

is selected? 

(a) Form View 

(b) Datasheet View 
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(c) Design View ✅ 

(d) Layout View 

11. Which key is used to move from one field to another 

while entering data in a form? 

(a) Enter 

(b) Shift 

(c) Tab ✅ 

(d) Ctrl 

12. A new record can be created at any time by clicking 

the: 

(a) Save button 

(b) Record Control Bar 

(c) New Record button ✅ 

(d) Design View 

13. Records entered through a form are: 

(a) Saved manually 

(b) Saved after closing the form 
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(c) Saved automatically ✅ 

(d) Saved using Save As option 

14. Which option is used to turn grid lines ON or OFF in 

Design View? 

(a) Format Grid 

(b) View Grid ✅ 

(c) Snap to Grid 

(d) Tab Order 

15. To change the order in which the cursor moves 

between form objects, which option is used? 

(a) View Toolbox 

(b) Format Snap to Grid 

(c) View Tab Order ✅ 

(d) Insert Page Numbers 

16. Which control displays all available values at once 

during data entry? 

(a) Combo box 
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(b) Text box 

(c) List box ✅ 

(d) Command button 

17. In a combo box, the list of values is displayed when: 

(a) The form opens 

(b) Data is saved 

(c) The arrow button is clicked ✅ 

(d) Design View is selected 

18. Check boxes and radio buttons are commonly used to 

display: 

(a) Numeric values 

(b) Text values 

(c) Yes/No or True/False values ✅ 

(d) Calculated fields 

19. Which statement about radio buttons is correct? 

(a) All options can be selected 
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(b) Only one option can be selected at a time ✅ 

(c) They are used for long lists 

(d) They store text only 

20. Which wizard appears when you draw a command 

button on a form? 

(a) Form Wizard 

(b) Control Wizard 

(c) Command Button Wizard ✅ 

(d) Option Group Wizard 

21. A subform is a form that is placed inside a: 

(a) Query 

(b) Table 

(c) Report 

(d) Main form ✅ 

22. Subforms are mainly used when tables have: 

(a) One-to-one relationship 
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(b) Many-to-many relationship 

(c) One-to-many relationship ✅ 

(d) No relationship 

23. In a one-to-many relationship, the subform represents 

the: 

(a) One side 

(b) Parent table 

(c) Main form 

(d) Many side ✅ 

24. A main form and subform can be created 

automatically using: 

(a) Design View 

(b) Subform Wizard 

(c) Form Wizard ✅ 

(d) Report Wizard 

25. Which option is selected to display the main form and 

subform on the same page? 

 
9 



 

 
 

(a) Linked forms 

(b) Form with subform(s) ✅ 

(c) Tabular form 

(d) Datasheet form 

26. Which layouts can be selected for a subform while 

using the Form Wizard? 

(a) Columnar and Justified 

(b) Graph and Chart 

(c) Tabular or Datasheet ✅ 

(d) Label and Text 

27. Which wizard is used when the main form already 

exists? 

(a) Form Wizard 

(b) Command Button Wizard 

(c) Subform Wizard ✅ 

(d) Control Wizard 
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28. To insert a subform using Subform Wizard, the main 

form must be opened in: 

(a) Form View 

(b) Datasheet View 

(c) Design View ✅ 

(d) Print Preview 

29. Before using the Drag-and-Drop method, what must 

already be set? 

(a) Form style 

(b) Page header 

(c) Table relationships ✅ 

(d) Control buttons 

30. In the Drag-and-Drop method, the subform is placed by 

dragging it into the: 

(a) Header section 

(b) Footer section 

(c) Detail section of main form ✅ 
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(d) Database window 

31. The presentation of processed data obtained from a 

database is called: 

(a) Form 

(b) Query 

(c) Report ✅ 

(d) Table 

32. A report in MS Access can be displayed: 

(a) Only on screen 

(b) Only on paper 

(c) Only on disk 

(d) On screen, paper, or disk ✅ 

33. Which of the following is NOT a use of reports? 

(a) Display information from database 

(b) Display query results 

(c) Produce output as per user needs 
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(d) Edit table structure ✅ 

34. The final product of most database applications is a: 

(a) Table 

(b) Query 

(c) Form 

(d) Report ✅ 

35. Reports in MS Access can retrieve data from: 

(a) Only one table 

(b) Only queries 

(c) One or more tables ✅ 

(d) Only forms 

36. Which type of report spreads information of a single 

record over many rows? 

(a) Tabular report 

(b) Datasheet report 

(c) Columnar report ✅ 
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(d) Graph report 

37. A tabular report displays data: 

(a) One record per page 

(b) In columns and rows ✅ 

(c) In vertical format 

(d) Like a form layout 

38. Which report type resembles the layout of a form? 

(a) Graph report 

(b) Datasheet report 

(c) Columnar report ✅ 

(d) Summary report 

39. Multi-page reports are commonly used for: 

(a) Order acknowledgement 

(b) Invoices 

(c) Catalogs and financial statements ✅ 

(d) Single receipts 

 
14 



 

 
 

40. Tab controls are mainly used to create: 

(a) Subforms 

(b) Reports 

(c) Multi-page forms ✅ 

(d) Queries 

41. Conditional formatting can be applied to: 

(a) Labels only 

(b) Tables only 

(c) Text boxes, lists, and combo boxes ✅ 

(d) Reports only 

42. Which condition applies formatting when the control is 

active? 

(a) Field Value Is 

(b) Expression Is 

(c) Field Has Focus ✅ 

(d) Default Value 
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43. Password text fields display typed characters as: 

(a) Numbers 

(b) Blank spaces 

(c) Dots 

(d) Asterisks (*) ✅ 

44. To change a control type without deleting it, which 

option is used? 

(a) View Change 

(b) Edit Control 

(c) Format Change To ✅ 

(d) Design Modify 

45. A composite primary key consists of: 

(a) One field 

(b) Two or more fields ✅ 

(c) Only numeric fields 

(d) Foreign keys 
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46. Which wizard helps in creating reports easily? 

(a) Form Wizard 

(b) Query Wizard 

(c) Report Wizard ✅ 

(d) Subform Wizard 

47. In Report Wizard, grouping of records is done: 

(a) Before selecting fields 

(b) After sorting 

(c) After selecting fields ✅ 

(d) At print time 

48. Sorting in a report can be: 

(a) Only ascending 

(b) Only descending 

(c) Both ascending and descending ✅ 

(d) Not possible 

49. To create a report from scratch, which view is used? 
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(a) Print View 

(b) Form View 

(c) Datasheet View 

(d) Design View ✅ 

50. To print a report, which option is used? 

(a) File ⟶ Save 

(b) File ⟶ Export 

(c) File ⟶ Print ✅ 

(d) File ⟶ Close 

51. Linking a table from another database means: 

(a) Copying the table into current database 

(b) Moving the table permanently 

(c) Creating a connection without copying data ✅ 

(d) Deleting the original table 

52. Which menu option is used to link tables from another 

database? 
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(a) File ⟶ Import 

(b) File ⟶ Get External ⟶ Link Tables ✅ 

(c) Edit ⟶ Link Tables 

(d) Tools ⟶ Database Utilities 

53. A linked table is shown in the Database Window as: 

(a) A normal table icon 

(b) A query icon 

(c) A table icon with a small arrow ✅ 

(d) A report icon 

54. The main purpose of a Switchboard form is to: 

(a) Store records 

(b) Print reports 

(c) Navigate to different parts of the database ✅ 

(d) Edit tables 

55. Which Access tool is used to create a Switchboard? 

(a) Form Wizard 
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(b) Report Wizard 

(c) Switchboard Manager Add-In ✅ 

(d) Control Wizard 

56. The Switchboard Manager is accessed through: 

(a) File ⟶ New 

(b) View ⟶ Toolbars 

(c) Tools ⟶ Database Utilities ⟶ Switchboard Manager ✅ 

(d) Edit ⟶ Preferences 

57. Which command is used to close both the Switchboard 

and the database? 

(a) Close Form 

(b) Exit Switchboard 

(c) Exit Application ✅ 

(d) Shutdown Access 

58. To make the Switchboard open automatically, which 

option is used? 

(a) Startup form option ✅ 
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(b) AutoCorrect 

(c) Page Setup 

(d) Macro editor 

59. In Switchboard Manager, the Text field is used to: 

(a) Store data 

(b) Write button description ✅ 

(c) Set primary key 

(d) Define queries 

60. Which option allows Access to run the Switchboard 

when the database opens? 

(a) Display Table 

(b) Display Query 

(c) Display Form/Page set to Switchboard ✅ 

(d) Default View 

‎📍 Important Short Questions: 

1. Write the uses of Reports. 

 
21 



 

 
 

Answer: 

👉 Reports present the required information in formatted 

style. 

👉 Reports provide flexibility to present the same data in 

different ways. 

👉 Reports can display information with graphics and charts. 

2. What is the difference between Form and Report? 

Answer: 

👉 Form: Used to enter data into the database visually using 

text boxes, buttons, and other controls. 

👉 Report: Used to display and retrieve data from tables or 

queries in a specific formatted style. 

3. What is the concept of Subform? 

Answer: 

👉 A subform is a form that is placed inside a parent form, 

called the main form. 

👉 Subforms are useful to display data from tables and 

queries with one-to-many relationships. 
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4. Define Form. 

Answer: 

👉 A form is a window consisting of visual components used to 

interact with a database through a graphical user interface. 

👉 It includes text boxes, labels, buttons, and other controls. 

5. Name two layouts of Forms in MS Access. 

Answer: 

👉 Columnar Form 

👉 Justified Form 

6. Describe Subform / State its purpose. 

Answer: 

👉 A subform is a form placed in a parent form. 

👉 It is used to display related data from tables and queries 

that have one-to-many relationships. 

7. Define Combo Box. 

Answer: 
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👉 A combo box displays a list of items in a form but occupies 

less space than a list box. 

👉 It consists of a text box and a drop-down list. 

👉 The user can select the desired item easily. 

8. Define List Box. 

Answer: 

👉 A list box displays a list of items in a form. 

👉 The user can select one or multiple items from the 

available options. 

👉 It occupies a fixed space and displays all items at once. 

9. Differentiate between Combo Box and List Box. 

Answer: 

👉 Combo Box: Shows items only when the dropdown is 

clicked, occupies less space, allows selection of one item. 

👉 List Box: Shows all items at once, occupies more space, 

allows selection of one or multiple items. 

10. Define Radio Button and its purpose. 
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Answer: 

👉 A radio button (option button) displays yes/no, true/false, 

or on/off options. 

👉 The user can select only one option from many options. 

👉 A dot appears when the option is selected. 

11. What are Check Boxes? 

Answer: 

👉 Check boxes display yes/no, true/false, or on/off options. 

👉 The user can select one or more options at the same time. 

12. Write two advantages of Forms. 

Answer: 

👉 Forms provide an easy interface to manipulate data. 

👉 Forms allow adding, editing, viewing, and searching records 

efficiently. 

13. Write two advantages of Reports. 

Answer: 

👉 Reports present data in a formatted and organized style. 
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👉 Reports can display data with graphics, charts, and images. 

14. Why is a Report generator used in database systems? 

Answer: 

👉 A report generator creates formatted output from 

database tables or queries. 

👉 It allows generating different types of reports for analysis 

and presentation. 

15. Write the use of Datasheet Form. 

Answer: 

👉 A datasheet form displays many records at a time in a 

tabular format. 

👉 Each row represents one record of a table or query. 

16. Why is a List Box used in Forms? 

Answer: 

👉 A list box displays a list of items for the user. 

👉 The user can select one or multiple items from the 

available options. 
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17. Distinguish between Form and Subform. 

Answer: 

👉 Form: A window with visual components to interact with 

the database, used for data entry and editing. 

👉 Subform: A form placed inside a main form, used to 

display related data efficiently in one-to-many relationships. 

18. Which control is used to execute commands in MS 

Access Forms? 

Answer: 

👉 A Command Button is used to execute commands. 

👉 The caption of the button indicates the type of command 

executed. 

19. What is a Switchboard? 

Answer: 

👉 A switchboard is a navigation form that allows the user to 

access different parts of the database easily. 

👉 It can open forms, reports, and queries using buttons. 
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20. How is a Switchboard created in MS Access? 

Answer: 

👉 Open Tools → Database Utilities → Switchboard Manager. 

👉 Add items (buttons) with commands to open forms, 

reports, or exit the database. 

21. How can a Switchboard be opened automatically at 

database startup? 

Answer: 

👉 Right-click the database window ⟶ select Startup ⟶ choose 

the Switchboard form under Display Form/Page ⟶ click OK. 

22. Define Linking in MS Access. 

Answer: 

👉 Linking creates a connection to a table in another database 

without copying it. 

👉 Linked tables appear with a small arrow icon in the current 

database. 

23. What is Conditional Formatting in Forms or Reports? 
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Answer: 

👉 Conditional formatting applies special formatting to a 

control based on its value, expression, or focus. 

25. How can a text box be modified to display typed 

characters as asterisks (*)? 

Answer: 

👉 In Design View  ⟶ select text box ⟶ Properties ⟶ Data tab 

⟶ Input Mask ⟶ select Password. 

26. What is a Composite Primary Key? 

Answer: 

👉 A composite primary key consists of two or more fields that 

together uniquely identify a record. 

27. Give one use of Tab Controls in Forms. 

Answer: 

👉 Tab controls allow multi-page forms, displaying multiple 

sections of data on separate tabs in a single form. 

28. Why are Reports important in MS Access? 

 
29 



 

 
 

Answer: 

👉 Reports present processed data in a readable, formatted 

style for analysis, printing, and decision-making. 

29. List two methods of creating Subforms. 

Answer: 

👉 Using Form Wizard to create main form and subform 

together. 

👉 Using Drag-and-Drop method with two existing forms. 

30. Define Subform in one line. 

Answer: 

👉 A subform is a form placed inside a main form to display 

related data from tables or queries. 

‎📍Exercise 7c 
1.Fill in the blank: 

1. Forms are used to -------- , ---------  and ----------  data in 

database. 

Answer: add, edit, view 
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Explain: Forms allow users to enter, modify, and see data in 

the database easily. 

2. The easiest and quick way to create a form in Microsoft 

Access is by using ------. 

Answer: Form Wizard 

Explain: Form Wizard automatically creates a form by 

selecting fields from tables or queries. 

3. ------- is used to display multiple records at a time in tabular 

format. 

Answer: Datasheet Form 

Explain: Datasheet Form displays many records together in 

rows and columns like a table. 

4. A ------- is a form, which is displayed within the main form. 

Answer: Subform 

Explain: A Subform shows related data from another table 

inside a main form, useful for one-to-many relationships. 

5. There are basically ------- layouts of forms in Microsoft 

Access. 
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Answer: Four 

Explain: The four layouts are Columnar, Tabular, Datasheet, 

and Justified. 

6. The ------ object is used only to retrieve data from a database 

and display it on the screen or print it on the printer. It cannot 

be used to edit data in a database. 

Answer: Report 

Explain: Reports present data in a formatted way for printing 

or viewing, but cannot modify it. 

7. ------- are can compare, summarize, and subtotal large sets 

of data. 

Answer: Reports 

Explain: Reports allow summarizing, totaling, and analyzing 

data from tables and queries. 

8. In Microsoft Access, a report can be created in any one of 

the three layouts. These layouts are ------,------- and --------. 

Answer: Columnar, Tabular, Justified 
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Explain: These layouts control how data appears in the report 

for printing and viewing. 

9. Reports are the finished result of your data input to the 

database backed through the forms as --------- end. 

Answer: Output 

Explain: Reports are the final output of database work, ready 

for printing or presenting. 

10. The -------- object is used only to retrieve data from a 

database and displays it on the screen or print it on the 

printer. It cannot be used to edit data in a database. 

Answer: Report 

Explain: Report is strictly for displaying and printing data, not 

for editing it. 

2. Choose the Correct Option. 

1. Forms are designed for: 

a) Input Data 

b) Manipulate Data 

c) Accepting Change 
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d) All of them ✅ 

2. A form that contains the subform is called ------. 

a) Form 

b) Main Form ✅ 

c) Report 

d) None of them 

3. You can drag the ------- bar to move the property sheet 

window around on your screen. 

a) Title bar ✅ 

b) Status bar 

c) Scroll bar 

d) All of them 

4. How many are basic layouts of forms in Microsoft 

Access? 

a) 2 

b) 3 

c) 4 ✅ 

 
34 



 

 
 

d) 5 

5. The forms are the ------ end of our database in Microsoft 

Access. 

a) Back end 

b) Front end ✅ 

c) Both a and b 

d) None of them 

6. A ------ Auto form displays one record at a time. 

a) Tabular 

b) Columnar ✅ 

c) Datasheet 

d) Justified 

7. A report provides a column for each field of the records 

in rows under the column header is known as: 

a) Tabular ✅ 

b) Columnar 

c) Datasheet 
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d) Justified 

8. ------ can be previewed on the screen before printing. 

a) Report ✅ 

b) Form 

c) Subform 

d) None of them 

9. Which of the following is used to retrieve data from one 

or more tables of database and to present it to the user in 

a formatted way? 

a) Report ✅ 

b) Form 

c) Query 

d) Table 

10. How many are the layout of report? 

a) 2 

b) 3 ✅ 

c) 4 
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d) 5 

3. Write T for true and F for false statement. 

(i) A form can enter, edit, and retrieve data from only one 

table at a time. ❌ F 

Explain: A form can work with multiple tables if subforms or 

queries are used. It is not limited to a single table. 

(ii) When a form is closed, the records entered in the form are 

automatically saved in the database. ✅ T 

Explain: Access automatically saves any data entered in the 

form when it is closed. 

(iii) We cannot change any record of a table in a database 

using a form. ❌ F 

Explain: Forms allow users to enter, edit, and update table 

records, so records can be changed using a form. 

(iv) A form within another form is known as tabular form. ❌ F 

Explain: A form inside another form is called a subform, not a 

tabular form. Tabular refers to the layout of multiple records. 

(v) The tabular layout of a form is called datasheet layout. ✅ T 
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Explain: In tabular layout, records are displayed in rows and 

columns, which is called the datasheet layout. 

(vi) We have not any facility to test a conditional statement in 

reports. ❌ F 

Explain: Access reports support conditional formatting, which 

allows formatting based on values or expressions. 

(vii) The easiest way to create a report in Microsoft Access is 

by using the Report Wizard. ✅ T 

Explain: The Report Wizard automatically selects fields, 

layouts, and formatting, making report creation easier. 

(viii) The options for layout of report are Columnar, Tabular, 

and Justified. ✅ T 

Explain: These three layout options help present data clearly 

in reports. 

(ix) Reports are primarily used to input data easily into 

database tables. ❌ F 

Explain: Reports are used to display and print data, not for 

data entry. Forms are used for input. 
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(x) The record navigation buttons at the lower-left corner of a 

form are used to save recently edited data in the database. ✅ 

T 

Explain: These buttons are used to navigate records, and 

Access automatically saves the changes in the database. 

🌟Q.4: Define the different layouts of forms: 

In Microsoft Access, forms can be designed in different layouts 

to display and manage data. The main layouts are: 

1. Columnar Form: 

●​ Displays one record at a time. 

●​ Each field of the record has its label on the left and a text 

box on the right. 

●​ Best for detailed entry and editing of a single record. 

2. Tabular Form (Datasheet Layout): 

●​ Displays multiple records at the same time in a table 

format. 

●​ Each row represents a record, and each column 

represents a field. 
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●​ Useful for quick data viewing and editing of many 

records. 

3. Justified Form: 

●​ Arranges fields across the entire width of the form. 

●​ Can display one record at a time. 

●​ Good for professional-looking forms where all fields need 

to fit neatly on a single page. 

4. Datasheet Form: 

●​ Similar to a spreadsheet, showing rows and columns. 

●​ Users can add, edit, and delete records directly. 

●​ Best for large sets of data where multiple records must 

be accessed quickly. 

✦ Summary: 

●​ Columnar ⟶ One record, detailed view. 

●​ Tabular/Datasheet ⟶ Multiple records, quicker view. 

●​ Justified ⟶ Full width, professional look. 

🌟 Q.5: Difference between Forms and Reports 

Forms: 
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●​ A form is a window or interface in a database that allows 

users to enter, edit, and view data easily. 

●​ It provides a graphical interface, meaning you can use 

text boxes, combo boxes, buttons, and checkboxes to 

interact with the data, instead of typing SQL queries. 

●​ Forms are mainly used for data input and manipulation, 

so they are interactive. 

●​ You can have features like navigation buttons, subforms, 

and combo/list boxes to make data entry easier. 

Example: A student admission form where the user can fill in 

the name, roll number, and class of students. 

Reports: 

●​ A report is used to retrieve and present data from a 

database in a formatted manner for printing or viewing. 

●​ Unlike forms, reports are not interactive. You cannot edit 

the data directly through a report. 

●​ Reports are used for summarizing, analyzing, and 

presenting data. They can include graphics, charts, 

headings, and multiple page layouts. 
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Example: A monthly attendance report or fee collection report 

that shows all students’ data in an organized format for 

printing. 

Key Differences: 

●​ Purpose: Forms are for input; Reports are for output. 

●​ Interactivity: Forms allow editing; Reports are read-only. 

●​ Presentation: Forms are designed for convenience in 

data entry; Reports are designed for presentation and 

printing. 

●​ Elements: Forms include buttons and interactive 

controls; Reports include charts, labels, and formatted 

data. 

✦ Summary: 

●​ Forms ⟶ Data entry and manipulation 

●​ Reports ⟶ Data display and presentation 

🌟 Q.6: How is a form created by using the Form Wizard? 

❖ Answer: 

A form can be easily created in Microsoft Access by using the 

Form Wizard. The steps are: 
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1.​Open the database in which you want to create the form. 

2.​Go to the Create tab and click on Form Wizard. 

3.​In the wizard, select the table or query from which the 

form will get its data. 

4.​Choose the fields you want to include in the form and 

move them to the selected fields section. 

5.​Click Next and select the layout of the form, such as 

Columnar, Tabular, Datasheet, or Justified. 

6.​Click Next and choose a style for the form. 

7.​Click Next and give a name to the form. 

8.​Finally, click Finish. The form is now created and ready to 

use. 

Explanation: 

●​ The Form Wizard makes creating forms quick and easy 

because it automatically generates the form layout and 

design based on the selected table or query. 

●​ It allows the user to view, add, or edit data in a 

user-friendly way without manually designing the form. 

🌟 Q.7: Explain the process for editing data through forms. 

❖ Answer: 
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Editing data through forms in Microsoft Access is simple and 

user-friendly. The process is as follows: 

1.​Open the Form: First, open the form that is linked to the 

table or query containing the data you want to edit. 

2.​Locate the Record: Use the record navigation buttons at 

the bottom of the form to move through records and 

locate the one you want to edit. 

3.​Edit the Fields: Click on the text box, combo box, or 

other controls in the form where the data is displayed. 

Make the necessary changes directly in the control. 

4.​Save the Changes: After editing, the changes are usually 

automatically saved when you move to another record or 

close the form. 

5.​Use Undo Option (Optional): If a mistake is made while 

editing, you can press Ctrl + Z or click the Undo button to 

revert the changes before leaving the record. 

6.​Close the Form: Once all edits are done, close the form. 

All changes are updated in the underlying table or query. 

Explanation: 

●​ Forms provide a visual and organized interface for editing 

data, which is easier than directly editing tables. 
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●​ Users can edit multiple fields of a record at once without 

worrying about the table structure. 

●​ Editing through forms ensures data integrity because the 

form controls can restrict incorrect data entry. 

🌟 Q.8: What is Subform? 

❖ Answer: 

A subform is a form placed inside another form, which is 

called the main form. It is used to display and manage data 

that has a one-to-many relationship between tables or 

queries. 

Purpose and Features: 

1.​Organized Display: Subforms allow related data to be 

displayed together in a structured way. 

2.​One-to-Many Relationship: The main form represents 

the “one” side, and the subform shows the “many” side of 

the relationship. 

3.​Data Entry and Editing: Users can enter, view, or edit 

multiple related records in one place without opening 

separate forms. 
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4.​Linked Records: Subforms are usually linked to the main 

form through a common field, like Customer ID or 

Product ID, ensuring only related records appear. 

5.​Improves Usability: Makes working with complex 

databases easier and more intuitive. 

Example: 

●​ Main Form: Customer Information 

○​ Name: Ali 

○​ Customer ID: 101 

●​ Subform: Orders for that customer 

○​ Order 1: 05/01/2026 

○​ Order 2: 08/01/2026 

Here, the subform displays all orders for Ali, while the main 

form shows Ali’s details. 

✦ Summary: 

●​ A subform is embedded within a main form. 

●​ It displays related data from one-to-many relationships. 

●​ It helps in easy data entry, editing, and viewing. 

●​ Subforms are linked through a common field for accurate 

and organized data display. 
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🌟 Q.9: How is a Form Created for a Single Table? 

❖ Answer: 

Creating a form for a single table in Microsoft Access is a 

simple process that allows users to enter, view, and edit data 

easily. A form acts as a graphical interface for interacting with 

the table. 

Steps to Create a Form for a Single Table: 

1.​Open Microsoft Access: Launch the database that 

contains the table. 

2.​Select the Table: In the Navigation Pane, click the table 

for which you want to create the form. 

3.​Use the Form Tool: 

○​ Go to the Create tab on the Ribbon. 

○​ Click on Form under the Forms group. 

○​ Access will automatically create a form that displays 

all the fields of the selected table. 

4.​Form Design (Optional): 

○​ You can switch to Design View or Layout View to 

adjust the form layout. 
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○​ Add labels, text boxes, combo boxes, checkboxes, or 

buttons for better usability. 

5.​Save the Form: 

○​ After making changes, click Save and give the form a 

meaningful name. 

○​ The form is now ready for data entry, viewing, and 

editing. 

Advantages of Creating a Form for a Single Table: 

●​ Simplifies data entry. 

●​ Prevents users from directly editing the table structure. 

●​ Provides a friendly visual interface. 

●​ Can include controls like combo boxes, checkboxes, and 

command buttons to improve functionality. 

✦ Summary: 

●​ A single-table form allows interaction with one table at a 

time. 

●​ It can be created automatically using the Form tool or 

customized in Design View. 

●​ The form improves data entry, editing, and presentation 

without affecting the table structure. 
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🌟 Q.10: What is a Report? 

❖ Answer: 

A report is a database object in Microsoft Access that is used 

to retrieve, organize, and present data from one or more 

tables or queries in a formatted and readable way. Reports are 

mainly used for printing and sharing data rather than editing 

it. 

Key Points about Reports: 

●​ Reports display data in a structured format using labels, 

text boxes, and headings. 

●​ They can include graphics, charts, and totals to 

summarize information. 

●​ Reports can be single-page or multi-page, depending on 

the amount of data. 

●​ They are primarily used to analyze, summarize, and print 

the database information. 

Uses of Reports: 

●​ To present data in a professional, formatted layout. 

●​ To summarize data with totals, counts, and averages. 
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●​ To display information from one or more tables in a 

structured form. 

●​ To provide printed copies of database records for 

management, meetings, or reports. 

✦ Summary: 

●​ A report is a read-only object for presenting database 

data. 

●​ It cannot be used to enter or edit data. 

●​ Reports provide flexibility to display data with graphics, 

grouping, and calculated fields. 

🌟 Q.11: How can you save and close an Auto Report? 

❖ Answer: 

When you create an Auto Report in Microsoft Access, it is 

automatically generated based on the selected table or query. 

After creating the report, you can save and close it by following 

these steps: 

Steps to Save and Close an Auto Report: 

1. Save the Report: 

●​ Click the File menu on the top-left corner of Access. 
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●​ Select Save or Save As. 

●​ Enter a name for the report that is meaningful and easy 

to identify. 

●​ Click OK. 

2. Close the Report: 

●​ After saving, click the Close (X) button at the top-right 

corner of the report window. 

●​ Alternatively, go to the File menu and click Close. 

Additional Notes: 

●​ Once saved, the report can be opened again from the 

Reports section in the Navigation Pane. 

●​ Any changes made to the layout after creating an Auto 

Report can be saved by clicking Save again. 

✦ Summary: 

●​ Saving ensures that your report is stored in the database 

for future use. 

●​ Closing removes the report window from view but does 

not delete it. 

●​ Auto Reports provide a quick way to view data, and saving 

them allows for repeated use without recreating. 
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🌟 Q.12: How to Create a Report Using the Report Wizard 

A Report is a formatted output of data from a database that 

can be printed or displayed on the screen. The Report Wizard 

in Microsoft Access helps create reports easily by guiding the 

user step by step. 

Steps to Create a Report Using Report Wizard: 

1. Open the Database 

●​ Open the Microsoft Access database where you want the 

report. 

2. Launch Report Wizard 

●​ Go to the Create tab on the Ribbon. 

●​ Click Report Wizard. This will open a step-by-step guide. 

3. Select Data Source 

●​ Choose the table or query from which you want to fetch 

data for the report. 

●​ Click Next. 

4. Select Fields 
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●​ From the list of Available Fields, select the fields you want 

in your report. 

●​ Move them to the Selected Fields box using the > button. 

●​ Click Next. 

5. Group Records (Optional) 

●​ You can group records based on a field like Department, 

Category, or Class. 

●​ This helps organize data into sections. 

●​ Click Next. 

6. Sort Records 

●​ Choose fields to sort your records (e.g., by Name, Date, or 

ID). 

●​ You can choose Ascending or Descending order. 

●​ Click Next. 

7. Choose Layout and Orientation 

●​ Select a layout for your report: 

➤ Columnar – displays one record at a time like a form. 

➤ Tabular – displays multiple records in rows like a table. 

➤ Justified – spreads data evenly across the page. 
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●​ Choose Portrait or Landscape for page orientation. 

●​ Click Next. 

8. Choose Style 

●​ Select a color and font style for your report (e.g., Bold, 

Casual, Professional). 

●​ Click Next. 

9. Name the Report 

●​ Enter a meaningful name for your report. 

●​ Choose whether to preview the report or modify its 

design. 

●​ Click Finish. 

10. View the Report 

●​ The report will be displayed on the screen in the chosen 

layout and style. 

●​ You can now print or save the report. 

✦ Summary: 

●​ Report Wizard is a step-by-step tool for creating 

professional reports quickly. 
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●​ It allows you to select data, group, sort, format, and style 

your report. 

●​ Reports created are easy to read, print, and distribute. 

●​ It is ideal for users who want a report without manually 

designing it from scratch. 

🌟 Q.13: How can you apply a sort order to a report? 

A sort order arranges the records in a report in a specific 

sequence, such as alphabetically, numerically, or by date. This 

makes it easier to read, analyze, and understand the data. 

Steps to Apply Sort Order in a Report: 

1. Open Report in Design or Wizard Mode 

●​ You can apply sorting while creating a report using the 

Report Wizard or on an existing report in Design View. 

2. Select the Field to Sort 

●​ Choose the field by which you want the report records to 

be arranged (for example, Student Name, Date of Order, 

or Employee ID). 

3. Choose the Sort Type 

Decide whether the sorting will be: 
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➤ Ascending (A-Z / smallest to largest) 

➤ Descending (Z-A / largest to smallest) 

4. Apply Multiple Sort Levels (Optional) 

●​ You can sort by more than one field. For example: 

➤ First by Department (Ascending) 

➤ Then by Employee Name (Ascending) within each 

Department 

5. Preview the Report 

●​ After applying the sort, preview the report to see if the 

records are displayed in the desired order. 

✦ Summary: 

●​ Sorting in reports helps organize and display data 

logically. 

●​ It can be applied during report creation using the Report 

Wizard or later in Design View. 

●​ Multiple sort levels can be used for better organization of 

records. 

🌟 Q.14: How is a report created from two tables? 
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Creating a report from two tables is useful when you want to 

display related data, such as customer details along with their 

orders. These tables usually have a relationship, commonly 

one-to-many, where one record in the main table corresponds 

to multiple records in the second table. 

Steps to Create a Report from Two Tables: 

1. Ensure Tables Are Related 

●​ Make sure there is a relationship defined between the 

two tables using the Relationships tool in Access. 

●​ Example: Customers table (main) and Orders table 

(related). 

2. Open Report Wizard 

●​ Go to the Create tab and select Report Wizard. 

●​ The wizard helps to combine fields from multiple tables 

easily. 

3. Select Tables and Fields 

●​ From the Tables/Queries drop-down, select the first table 

(main table) and move the required fields to the Selected 

Fields list. 

 
57 



 

 
 

●​ Then select the second table (related table) and add the 

required fields as well. 

4. Choose Grouping and Sorting 

●​ The wizard allows you to group records based on a 

common field (like Customer ID). 

●​ You can also apply sort order to the fields (Ascending or 

Descending). 

5. Select Layout and Style 

●​ Choose a layout such as Tabular, Columnar, or Justified. 

●​ Pick a style (color, font, or graphics) for the report. 

6. Name and Finish the Report 

●​ Give a name to the report and click Finish. 

●​ The report will now display records from both tables in a 

combined and formatted way. 

Example: 

●​ Main Table: Customers ⟶ Fields: Customer Name, 

Address 

●​ Related Table: Orders ⟶ Fields: Order ID, Product Name, 

Quantity 
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Result: A report showing each customer with their respective 

orders clearly grouped. 

✦ Summary: 

●​ Reports from two tables are used to display related data 

in a single report. 

●​ Use Report Wizard for easy creation. 

●​ Grouping and sorting make data organized and readable. 

🌟 Q.15: How can a report be created for a single table? 

A report for a single table is used when you want to display 

data from only one table in a formatted way, such as a student 

list, employee records, or product details. 

Steps to Create a Report for a Single Table: 

1. Open Microsoft Access 

●​ Open the database that contains the table for which you 

want to create a report. 

2. Select the Table 

●​ Go to the Create tab and click Report Wizard. 

●​ From the Tables/Queries drop-down menu, select the 

table you want to use. 
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3. Select Fields 

●​ Choose the fields from the table that you want to include 

in the report. 

●​ Move them to the Selected Fields list using the single (>) 

or double (>>) arrow. 

4. Grouping and Sorting (Optional) 

●​ If needed, you can group records by a specific field (like 

department or category). 

●​ You can also set the sort order for fields, either ascending 

or descending. 

5. Select Layout 

●​ Choose a report layout such as Tabular, Columnar, or 

Justified. 

●​ Tabular layout shows multiple records in rows and 

columns. 

●​ Columnar layout displays one record at a time. 

6. Choose Style 

●​ Pick a style or theme for your report, such as colors, 

fonts, and graphics. 
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7. Name and Finish 

●​ Give the report a name and click Finish. 

●​ The report will now display all records from the selected 

table in a formatted manner. 

Example: 

●​ Table: Students 

●​ Fields: Name, Roll Number, Class, Phone Number 

●​ Result: A report showing all student details in a readable 

and organized format. 

✦ Summary: 

●​ Reports for a single table display all records from that 

table. 

●​ Use Report Wizard for easy creation. 

●​ You can group, sort, and format the data for better 

readability. 

 

Note: 

‎This chapter is designed to provide a solid foundation of knowledge, with the goal of 

deepening understanding and encouraging further exploration of the subject. The content 

has been carefully selected to support effective learning and inspire students to engage 

with the topic more deeply. 
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	👉 Subform: A form placed inside a main form, used to display related data efficiently in one-to-many relationships. 
	18. Which control is used to execute commands in MS Access Forms? 
	Answer: 
	👉 A Command Button is used to execute commands. 
	👉 The caption of the button indicates the type of command executed. 
	19. What is a Switchboard? 
	Answer: 
	👉 A switchboard is a navigation form that allows the user to access different parts of the database easily. 
	👉 It can open forms, reports, and queries using buttons. 
	20. How is a Switchboard created in MS Access? 
	Answer: 
	👉 Open Tools → Database Utilities → Switchboard Manager. 
	👉 Add items (buttons) with commands to open forms, reports, or exit the database. 
	21. How can a Switchboard be opened automatically at database startup? 
	Answer: 
	👉 Right-click the database window ⟶ select Startup ⟶ choose the Switchboard form under Display Form/Page ⟶ click OK. 
	22. Define Linking in MS Access. 
	Answer: 
	👉 Linking creates a connection to a table in another database without copying it. 
	👉 Linked tables appear with a small arrow icon in the current database. 
	23. What is Conditional Formatting in Forms or Reports? 
	Answer: 
	👉 Conditional formatting applies special formatting to a control based on its value, expression, or focus. 
	25. How can a text box be modified to display typed characters as asterisks (*)? 
	Answer: 
	👉 In Design View  ⟶ select text box ⟶ Properties ⟶ Data tab ⟶ Input Mask ⟶ select Password. 
	26. What is a Composite Primary Key? 
	Answer: 
	👉 A composite primary key consists of two or more fields that together uniquely identify a record. 
	27. Give one use of Tab Controls in Forms. 
	Answer: 
	👉 Tab controls allow multi-page forms, displaying multiple sections of data on separate tabs in a single form. 
	28. Why are Reports important in MS Access? 
	Answer: 
	👉 Reports present processed data in a readable, formatted style for analysis, printing, and decision-making. 
	29. List two methods of creating Subforms. 
	Answer: 
	👉 Using Form Wizard to create main form and subform together. 
	👉 Using Drag-and-Drop method with two existing forms. 
	30. Define Subform in one line. 
	Answer: 
	👉 A subform is a form placed inside a main form to display related data from tables or queries. 
	‎📍Exercise 7c 
	1.Fill in the blank: 
	1. Forms are used to -------- , ---------  and ----------  data in database. 
	Answer: add, edit, view 
	Explain: Forms allow users to enter, modify, and see data in the database easily. 
	2. The easiest and quick way to create a form in Microsoft Access is by using ------. 
	Answer: Form Wizard 
	Explain: Form Wizard automatically creates a form by selecting fields from tables or queries. 
	3. ------- is used to display multiple records at a time in tabular format. 
	Answer: Datasheet Form 
	Explain: Datasheet Form displays many records together in rows and columns like a table. 
	4. A ------- is a form, which is displayed within the main form. 
	Answer: Subform 
	Explain: A Subform shows related data from another table inside a main form, useful for one-to-many relationships. 
	5. There are basically ------- layouts of forms in Microsoft Access. 
	Answer: Four 
	Explain: The four layouts are Columnar, Tabular, Datasheet, and Justified. 
	6. The ------ object is used only to retrieve data from a database and display it on the screen or print it on the printer. It cannot be used to edit data in a database. 
	Answer: Report 
	Explain: Reports present data in a formatted way for printing or viewing, but cannot modify it. 
	7. ------- are can compare, summarize, and subtotal large sets of data. 
	Answer: Reports 
	Explain: Reports allow summarizing, totaling, and analyzing data from tables and queries. 
	8. In Microsoft Access, a report can be created in any one of the three layouts. These layouts are ------,------- and --------. 
	Answer: Columnar, Tabular, Justified 
	Explain: These layouts control how data appears in the report for printing and viewing. 
	9. Reports are the finished result of your data input to the database backed through the forms as --------- end. 
	Answer: Output 
	Explain: Reports are the final output of database work, ready for printing or presenting. 
	10. The -------- object is used only to retrieve data from a database and displays it on the screen or print it on the printer. It cannot be used to edit data in a database. 
	Answer: Report 
	Explain: Report is strictly for displaying and printing data, not for editing it. 
	2. Choose the Correct Option. 
	1. Forms are designed for: 
	a) Input Data 
	b) Manipulate Data 
	c) Accepting Change 
	d) All of them ✅ 
	2. A form that contains the subform is called ------. 
	a) Form 
	b) Main Form ✅ 
	c) Report 
	d) None of them 
	3. You can drag the ------- bar to move the property sheet window around on your screen. 
	a) Title bar ✅ 
	b) Status bar 
	c) Scroll bar 
	d) All of them 
	4. How many are basic layouts of forms in Microsoft Access? 
	a) 2 
	b) 3 
	c) 4 ✅ 
	d) 5 
	5. The forms are the ------ end of our database in Microsoft Access. 
	a) Back end 
	b) Front end ✅ 
	c) Both a and b 
	d) None of them 
	6. A ------ Auto form displays one record at a time. 
	a) Tabular 
	b) Columnar ✅ 
	c) Datasheet 
	d) Justified 
	7. A report provides a column for each field of the records in rows under the column header is known as: 
	a) Tabular ✅ 
	b) Columnar 
	c) Datasheet 
	d) Justified 
	8. ------ can be previewed on the screen before printing. 
	a) Report ✅ 
	b) Form 
	c) Subform 
	d) None of them 
	9. Which of the following is used to retrieve data from one or more tables of database and to present it to the user in a formatted way? 
	a) Report ✅ 
	b) Form 
	c) Query 
	d) Table 
	10. How many are the layout of report? 
	a) 2 
	b) 3 ✅ 
	c) 4 
	d) 5 
	3. Write T for true and F for false statement. 
	(i) A form can enter, edit, and retrieve data from only one table at a time. ❌ F 
	Explain: A form can work with multiple tables if subforms or queries are used. It is not limited to a single table. 
	(ii) When a form is closed, the records entered in the form are automatically saved in the database. ✅ T 
	Explain: Access automatically saves any data entered in the form when it is closed. 
	(iii) We cannot change any record of a table in a database using a form. ❌ F 
	Explain: Forms allow users to enter, edit, and update table records, so records can be changed using a form. 
	(iv) A form within another form is known as tabular form. ❌ F 
	Explain: A form inside another form is called a subform, not a tabular form. Tabular refers to the layout of multiple records. 
	(v) The tabular layout of a form is called datasheet layout. ✅ T 
	Explain: In tabular layout, records are displayed in rows and columns, which is called the datasheet layout. 
	(vi) We have not any facility to test a conditional statement in reports. ❌ F 
	Explain: Access reports support conditional formatting, which allows formatting based on values or expressions. 
	(vii) The easiest way to create a report in Microsoft Access is by using the Report Wizard. ✅ T 
	Explain: The Report Wizard automatically selects fields, layouts, and formatting, making report creation easier. 
	(viii) The options for layout of report are Columnar, Tabular, and Justified. ✅ T 
	Explain: These three layout options help present data clearly in reports. 
	(ix) Reports are primarily used to input data easily into database tables. ❌ F 
	Explain: Reports are used to display and print data, not for data entry. Forms are used for input. 
	(x) The record navigation buttons at the lower-left corner of a form are used to save recently edited data in the database. ✅ T 
	Explain: These buttons are used to navigate records, and Access automatically saves the changes in the database. 
	🌟Q.4: Define the different layouts of forms: 
	In Microsoft Access, forms can be designed in different layouts to display and manage data. The main layouts are: 
	1. Columnar Form: 
	●​Displays one record at a time. 
	●​Each field of the record has its label on the left and a text box on the right. 
	●​Best for detailed entry and editing of a single record. 
	2. Tabular Form (Datasheet Layout): 
	●​Displays multiple records at the same time in a table format. 
	●​Each row represents a record, and each column represents a field. 
	●​Useful for quick data viewing and editing of many records. 
	3. Justified Form: 
	●​Arranges fields across the entire width of the form. 
	●​Can display one record at a time. 
	●​Good for professional-looking forms where all fields need to fit neatly on a single page. 
	4. Datasheet Form: 
	●​Similar to a spreadsheet, showing rows and columns. 
	●​Users can add, edit, and delete records directly. 
	●​Best for large sets of data where multiple records must be accessed quickly. 
	✦ Summary: 
	●​Columnar ⟶ One record, detailed view. 
	●​Tabular/Datasheet ⟶ Multiple records, quicker view. 
	●​Justified ⟶ Full width, professional look. 
	🌟 Q.5: Difference between Forms and Reports 
	Forms: 
	●​A form is a window or interface in a database that allows users to enter, edit, and view data easily. 
	●​It provides a graphical interface, meaning you can use text boxes, combo boxes, buttons, and checkboxes to interact with the data, instead of typing SQL queries. 
	●​Forms are mainly used for data input and manipulation, so they are interactive. 
	●​You can have features like navigation buttons, subforms, and combo/list boxes to make data entry easier. 
	Example: A student admission form where the user can fill in the name, roll number, and class of students. 
	Reports: 
	●​A report is used to retrieve and present data from a database in a formatted manner for printing or viewing. 
	●​Unlike forms, reports are not interactive. You cannot edit the data directly through a report. 
	●​Reports are used for summarizing, analyzing, and presenting data. They can include graphics, charts, headings, and multiple page layouts. 
	Example: A monthly attendance report or fee collection report that shows all students’ data in an organized format for printing. 
	Key Differences: 
	●​Purpose: Forms are for input; Reports are for output. 
	●​Interactivity: Forms allow editing; Reports are read-only. 
	●​Presentation: Forms are designed for convenience in data entry; Reports are designed for presentation and printing. 
	●​Elements: Forms include buttons and interactive controls; Reports include charts, labels, and formatted data. 
	✦ Summary: 
	●​Forms ⟶ Data entry and manipulation 
	●​Reports ⟶ Data display and presentation 
	🌟 Q.6: How is a form created by using the Form Wizard? 
	❖ Answer: 
	A form can be easily created in Microsoft Access by using the Form Wizard. The steps are: 
	1.​Open the database in which you want to create the form. 
	2.​Go to the Create tab and click on Form Wizard. 
	3.​In the wizard, select the table or query from which the form will get its data. 
	4.​Choose the fields you want to include in the form and move them to the selected fields section. 
	5.​Click Next and select the layout of the form, such as Columnar, Tabular, Datasheet, or Justified. 
	6.​Click Next and choose a style for the form. 
	7.​Click Next and give a name to the form. 
	8.​Finally, click Finish. The form is now created and ready to use. 
	Explanation: 
	●​The Form Wizard makes creating forms quick and easy because it automatically generates the form layout and design based on the selected table or query. 
	●​It allows the user to view, add, or edit data in a user-friendly way without manually designing the form. 
	🌟 Q.7: Explain the process for editing data through forms. 
	❖ Answer: 
	Editing data through forms in Microsoft Access is simple and user-friendly. The process is as follows: 
	1.​Open the Form: First, open the form that is linked to the table or query containing the data you want to edit. 
	2.​Locate the Record: Use the record navigation buttons at the bottom of the form to move through records and locate the one you want to edit. 
	3.​Edit the Fields: Click on the text box, combo box, or other controls in the form where the data is displayed. Make the necessary changes directly in the control. 
	4.​Save the Changes: After editing, the changes are usually automatically saved when you move to another record or close the form. 
	5.​Use Undo Option (Optional): If a mistake is made while editing, you can press Ctrl + Z or click the Undo button to revert the changes before leaving the record. 
	6.​Close the Form: Once all edits are done, close the form. All changes are updated in the underlying table or query. 
	Explanation: 
	●​Forms provide a visual and organized interface for editing data, which is easier than directly editing tables. 
	●​Users can edit multiple fields of a record at once without worrying about the table structure. 
	●​Editing through forms ensures data integrity because the form controls can restrict incorrect data entry. 
	🌟 Q.8: What is Subform? 
	❖ Answer: 
	A subform is a form placed inside another form, which is called the main form. It is used to display and manage data that has a one-to-many relationship between tables or queries. 
	Purpose and Features: 
	1.​Organized Display: Subforms allow related data to be displayed together in a structured way. 
	2.​One-to-Many Relationship: The main form represents the “one” side, and the subform shows the “many” side of the relationship. 
	3.​Data Entry and Editing: Users can enter, view, or edit multiple related records in one place without opening separate forms. 
	4.​Linked Records: Subforms are usually linked to the main form through a common field, like Customer ID or Product ID, ensuring only related records appear. 
	5.​Improves Usability: Makes working with complex databases easier and more intuitive. 
	Example: 
	●​Main Form: Customer Information 
	○​Name: Ali 
	○​Customer ID: 101 
	●​Subform: Orders for that customer 
	○​Order 1: 05/01/2026 
	○​Order 2: 08/01/2026 
	Here, the subform displays all orders for Ali, while the main form shows Ali’s details. 
	✦ Summary: 
	●​A subform is embedded within a main form. 
	●​It displays related data from one-to-many relationships. 
	●​It helps in easy data entry, editing, and viewing. 
	●​Subforms are linked through a common field for accurate and organized data display. 
	🌟 Q.9: How is a Form Created for a Single Table? 
	❖ Answer: 
	Creating a form for a single table in Microsoft Access is a simple process that allows users to enter, view, and edit data easily. A form acts as a graphical interface for interacting with the table. 
	Steps to Create a Form for a Single Table: 
	1.​Open Microsoft Access: Launch the database that contains the table. 
	2.​Select the Table: In the Navigation Pane, click the table for which you want to create the form. 
	3.​Use the Form Tool: 
	○​Go to the Create tab on the Ribbon. 
	○​Click on Form under the Forms group. 
	○​Access will automatically create a form that displays all the fields of the selected table. 
	4.​Form Design (Optional): 
	○​You can switch to Design View or Layout View to adjust the form layout. 
	○​Add labels, text boxes, combo boxes, checkboxes, or buttons for better usability. 
	5.​Save the Form: 
	○​After making changes, click Save and give the form a meaningful name. 
	○​The form is now ready for data entry, viewing, and editing. 
	Advantages of Creating a Form for a Single Table: 
	●​Simplifies data entry. 
	●​Prevents users from directly editing the table structure. 
	●​Provides a friendly visual interface. 
	●​Can include controls like combo boxes, checkboxes, and command buttons to improve functionality. 
	✦ Summary: 
	●​A single-table form allows interaction with one table at a time. 
	●​It can be created automatically using the Form tool or customized in Design View. 
	●​The form improves data entry, editing, and presentation without affecting the table structure. 
	🌟 Q.10: What is a Report? 
	❖ Answer: 
	A report is a database object in Microsoft Access that is used to retrieve, organize, and present data from one or more tables or queries in a formatted and readable way. Reports are mainly used for printing and sharing data rather than editing it. 
	Key Points about Reports: 
	●​Reports display data in a structured format using labels, text boxes, and headings. 
	●​They can include graphics, charts, and totals to summarize information. 
	●​Reports can be single-page or multi-page, depending on the amount of data. 
	●​They are primarily used to analyze, summarize, and print the database information. 
	Uses of Reports: 
	●​To present data in a professional, formatted layout. 
	●​To summarize data with totals, counts, and averages. 
	●​To display information from one or more tables in a structured form. 
	●​To provide printed copies of database records for management, meetings, or reports. 
	✦ Summary: 
	●​A report is a read-only object for presenting database data. 
	●​It cannot be used to enter or edit data. 
	●​Reports provide flexibility to display data with graphics, grouping, and calculated fields. 
	🌟 Q.11: How can you save and close an Auto Report? 
	❖ Answer: 
	When you create an Auto Report in Microsoft Access, it is automatically generated based on the selected table or query. After creating the report, you can save and close it by following these steps: 
	Steps to Save and Close an Auto Report: 
	1. Save the Report: 
	●​Click the File menu on the top-left corner of Access. 
	●​Select Save or Save As. 
	●​Enter a name for the report that is meaningful and easy to identify. 
	●​Click OK. 
	2. Close the Report: 
	●​After saving, click the Close (X) button at the top-right corner of the report window. 
	●​Alternatively, go to the File menu and click Close. 
	Additional Notes: 
	●​Once saved, the report can be opened again from the Reports section in the Navigation Pane. 
	●​Any changes made to the layout after creating an Auto Report can be saved by clicking Save again. 
	✦ Summary: 
	●​Saving ensures that your report is stored in the database for future use. 
	●​Closing removes the report window from view but does not delete it. 
	●​Auto Reports provide a quick way to view data, and saving them allows for repeated use without recreating. 
	🌟 Q.12: How to Create a Report Using the Report Wizard 
	A Report is a formatted output of data from a database that can be printed or displayed on the screen. The Report Wizard in Microsoft Access helps create reports easily by guiding the user step by step. 
	Steps to Create a Report Using Report Wizard: 
	1. Open the Database 
	●​Open the Microsoft Access database where you want the report. 
	2. Launch Report Wizard 
	●​Go to the Create tab on the Ribbon. 
	●​Click Report Wizard. This will open a step-by-step guide. 
	3. Select Data Source 
	●​Choose the table or query from which you want to fetch data for the report. 
	●​Click Next. 
	4. Select Fields 
	●​From the list of Available Fields, select the fields you want in your report. 
	●​Move them to the Selected Fields box using the > button. 
	●​Click Next. 
	5. Group Records (Optional) 
	●​You can group records based on a field like Department, Category, or Class. 
	●​This helps organize data into sections. 
	●​Click Next. 
	6. Sort Records 
	●​Choose fields to sort your records (e.g., by Name, Date, or ID). 
	●​You can choose Ascending or Descending order. 
	●​Click Next. 
	7. Choose Layout and Orientation 
	●​Select a layout for your report: 
	➤ Columnar – displays one record at a time like a form. 
	➤ Tabular – displays multiple records in rows like a table. 
	➤ Justified – spreads data evenly across the page. 
	●​Choose Portrait or Landscape for page orientation. 
	●​Click Next. 
	8. Choose Style 
	●​Select a color and font style for your report (e.g., Bold, Casual, Professional). 
	●​Click Next. 
	9. Name the Report 
	●​Enter a meaningful name for your report. 
	●​Choose whether to preview the report or modify its design. 
	●​Click Finish. 
	10. View the Report 
	●​The report will be displayed on the screen in the chosen layout and style. 
	●​You can now print or save the report. 
	✦ Summary: 
	●​Report Wizard is a step-by-step tool for creating professional reports quickly. 
	●​It allows you to select data, group, sort, format, and style your report. 
	●​Reports created are easy to read, print, and distribute. 
	●​It is ideal for users who want a report without manually designing it from scratch. 
	🌟 Q.13: How can you apply a sort order to a report? 
	A sort order arranges the records in a report in a specific sequence, such as alphabetically, numerically, or by date. This makes it easier to read, analyze, and understand the data. 
	Steps to Apply Sort Order in a Report: 
	1. Open Report in Design or Wizard Mode 
	●​You can apply sorting while creating a report using the Report Wizard or on an existing report in Design View. 
	2. Select the Field to Sort 
	●​Choose the field by which you want the report records to be arranged (for example, Student Name, Date of Order, or Employee ID). 
	3. Choose the Sort Type 
	Decide whether the sorting will be: 
	➤ Ascending (A-Z / smallest to largest) 
	➤ Descending (Z-A / largest to smallest) 
	4. Apply Multiple Sort Levels (Optional) 
	●​You can sort by more than one field. For example: 
	➤ First by Department (Ascending) 
	➤ Then by Employee Name (Ascending) within each Department 
	5. Preview the Report 
	●​After applying the sort, preview the report to see if the records are displayed in the desired order. 
	✦ Summary: 
	●​Sorting in reports helps organize and display data logically. 
	●​It can be applied during report creation using the Report Wizard or later in Design View. 
	●​Multiple sort levels can be used for better organization of records. 
	🌟 Q.14: How is a report created from two tables? 
	Creating a report from two tables is useful when you want to display related data, such as customer details along with their orders. These tables usually have a relationship, commonly one-to-many, where one record in the main table corresponds to multiple records in the second table. 
	Steps to Create a Report from Two Tables: 
	1. Ensure Tables Are Related 
	●​Make sure there is a relationship defined between the two tables using the Relationships tool in Access. 
	●​Example: Customers table (main) and Orders table (related). 
	2. Open Report Wizard 
	●​Go to the Create tab and select Report Wizard. 
	●​The wizard helps to combine fields from multiple tables easily. 
	3. Select Tables and Fields 
	●​From the Tables/Queries drop-down, select the first table (main table) and move the required fields to the Selected Fields list. 
	●​Then select the second table (related table) and add the required fields as well. 
	4. Choose Grouping and Sorting 
	●​The wizard allows you to group records based on a common field (like Customer ID). 
	●​You can also apply sort order to the fields (Ascending or Descending). 
	5. Select Layout and Style 
	●​Choose a layout such as Tabular, Columnar, or Justified. 
	●​Pick a style (color, font, or graphics) for the report. 
	6. Name and Finish the Report 
	●​Give a name to the report and click Finish. 
	●​The report will now display records from both tables in a combined and formatted way. 
	Example: 
	●​Main Table: Customers ⟶ Fields: Customer Name, Address 
	●​Related Table: Orders ⟶ Fields: Order ID, Product Name, Quantity 
	Result: A report showing each customer with their respective orders clearly grouped. 
	✦ Summary: 
	●​Reports from two tables are used to display related data in a single report. 
	●​Use Report Wizard for easy creation. 
	●​Grouping and sorting make data organized and readable. 
	🌟 Q.15: How can a report be created for a single table? 
	A report for a single table is used when you want to display data from only one table in a formatted way, such as a student list, employee records, or product details. 
	Steps to Create a Report for a Single Table: 
	1. Open Microsoft Access 
	●​Open the database that contains the table for which you want to create a report. 
	2. Select the Table 
	●​Go to the Create tab and click Report Wizard. 
	●​From the Tables/Queries drop-down menu, select the table you want to use. 
	3. Select Fields 
	●​Choose the fields from the table that you want to include in the report. 
	●​Move them to the Selected Fields list using the single (>) or double (>>) arrow. 
	4. Grouping and Sorting (Optional) 
	●​If needed, you can group records by a specific field (like department or category). 
	●​You can also set the sort order for fields, either ascending or descending. 
	5. Select Layout 
	●​Choose a report layout such as Tabular, Columnar, or Justified. 
	●​Tabular layout shows multiple records in rows and columns. 
	●​Columnar layout displays one record at a time. 
	6. Choose Style 
	●​Pick a style or theme for your report, such as colors, fonts, and graphics. 
	7. Name and Finish 
	●​Give the report a name and click Finish. 
	●​The report will now display all records from the selected table in a formatted manner. 
	Example: 
	●​Table: Students 
	●​Fields: Name, Roll Number, Class, Phone Number 
	●​Result: A report showing all student details in a readable and organized format. 
	✦ Summary: 
	●​Reports for a single table display all records from that table. 
	●​Use Report Wizard for easy creation. 
	●​You can group, sort, and format the data for better readability. 
	Note: 


